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1. Introduction

1.1 Purpose This document describes how to install and use the Learner Information Suite
(LIS) version 17.03.

1.2
Background

The LIS is a part of the Data Service’s data capture systems that enable
efficient collection and management of learner information. Other parts
include:
 Provider Batch
 Provider On-line
 Learning Aim Database (LAD).

The LIS is designed for use by Provider Batch users.

LIS 17.03 is used to validate individualised learner record (ILR) data for
2009/10, calculate derived variables, calculate Employer Responsive (ER),
Learner Responsive (LR) funding data and run reports against this data. The
LIS also exports valid data and reports for transmission to the Data Service
through the Provider Batch online data collection portal.

Further help is available on the following websites:
 The Information Authority (IA); the ILR (including the validation rules used

by the LIS) is documented at:
http://www.theia.org.uk/downloads/ilrdocuments/

 The Data Service; LIS 17.03 documentation is available at :
http://www.thedataservice.org.uk/Services/DataCollection/software/lis/lis_
17_03.htm

1.3 Previous
Versions

LIS series 17 can co-exist with earlier series of the LIS. It can therefore be
installed on a PC which already has LIS 16 (or 15 or 14 or 13) installed. If
you have an earlier version of LIS series 17 installed on your PC, it is
recommended that you uninstall it first.

LIS series 17 is designed for use with 2009/10 ILR data for ER, LR, ASL,
ESF SR and UFI providers. Providers should continue to use LIS series 16
for processing their 2008/09 ILR returns.

Warning: It is advisable not to remove the shared files when uninstalling
some old versions of LIS.

1.4 Support
Materials

For support:
 check the LIS section of the Data Service’s website:

http://www.thedataservice.org.uk/Services/DataCollection/software/lis/

 Providers should contact the Data Service Service Desk by emailing
servicedesk@thedataservice.org.uk or calling 08702 670001
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2. Installing LIS

2.1 Overview The LIS installation files are available for download from the Data Service
website:
http://www.thedataservice.org.uk/Services/DataCollection/software/lis/lis_
17_03.htm

The software should be installed onto a PC matching at least the minimum
specification required. Refer to Section 2.2 System Requirements below.

2.2 System
Requirements

The LIS is supported on the following operating systems:

 Windows 2000
 Windows XP Home or Professional
 Windows Vista

The PC should ideally support an internet connection, to enable you to check
the Data Service website for updates, and to download the Learning Aim
Database (LAD).

Note: You or the person installing the LIS must have administrator rights on
the host PC in order to successfully install the software.

2.3
Downloading
LIS for
Installation

The installation files are located on the Data Service website for you to
download. unzip and install onto your PC. Users of Windows 2000 may need
additional software to unzip the installation files. To download the files,
complete the following steps:

Step Action

1 Launch your internet browser and navigate to the LIS section of
the Data Service website:
http://www.thedataservice.org.uk/Services/DataCollection/softwar
e/lis/

The page has links to the latest version for each teaching year,
and also to all previous versions for each teaching year.

2 Choose the LIS 17.03 page link to display the LIS 17.03 page, the
latest version of the LIS software is always put at the top of this
page. It contains file download links and gives access to useful
information about the software, which is updated when necessary.

3 Choose the full installation by clicking on the zip file download.

The file download dialogue box displays.
4 Select the option to Save this program to disk.

Click OK.
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5 Select the destination directory for the download on your PC.

Click Save.

The file will download to your PC in the location specified. The
download progress displays.
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2. Installing LIS, Continued

2.4 Running
the LIS
Installation

To be able to run the installation program you must use full administrator
rights on your PC.

Please contact your local IT Support team, regarding your administrator
rights.

Notes
1) Like LIS series 16, LIS 17 uses .NET Framework 2.0. The LIS

installation process will check whether this exists on the PC when it
runs, if it does not it will produce an error message. The .NET
framework 2.0 installation file is also available from the LIS download
page used previously. Download the .NET framework installation file
and re-run the LIS 17 installer.

2) Once installed, the LIS will also require a postcode data file to be
imported. This can also be found on the LIS download page along
with a Data Update file, the latest versions will always be available
from this page. Guidance on updating the LIS with Data Update can
be found within Section 16.7 Updating your LIS Data (See page 78).

3) Users who have installed the LIS 17 Beta version, should uninstall it
before installing any later released versions.

4) The software should only be installed locally from the hard disk of a
PC and not from a network drive. It is recommended that you close
down all other applications before beginning the installation process.

Important: When the software has been installed on a Microsoft Vista
machine, the software should be run once whilst the administrator rights are
in operation. Otherwise, the software may not work for people with standard
user rights.

To run the installation, complete the following steps:

Step Action

1 Unzip the downloaded LIS file and navigate to the location.

Double click the file setup.exe.

The Preparing to Install screen displays.

Cancel stops the installation programme.

Once the Preparing to Install screen is complete, the Welcome
screen appears.

2 Click Next.

The Choose Destination Location dialogue box displays.

Continued on next page
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2. Installing LIS, Continued

2.4 Running the LIS Installation, continued

Step Action

3 Use the table below to help decide:

IF… THEN…

You click
Browse

The Choose Folder dialogue box displays.
Select the required location for the
installation. Click OK.
Cancel will cancel the selected location
and maintain the default setting.
Go to step 4.

You click Back You return to the previous Welcome
screen as in step 1.

You click Next The Setup Status screen displays. Go to
step 5.

You click
Cancel

You will exit the installation programme.
Please refer to Section 2.5 Cancelling the
LIS Installation (See page 10).

4 Click Next. The installation begins and the setup status screen
displays.

5 You may be required to restart your PC once the installation is
complete. Click the radio button to select the option required.

Note: If you are prompted to restart your computer after the
software installation, it is favourable that you do so, to ensure the
application will work correctly. Whether the prompt displays or not
depends on your PC configuration.

6 Click Finish. The installation is complete. A shortcut icon is now
present on the desktop.

The software is also accessible from the Start | Programs list.

2.5 Cancelling
the LIS
Installation

You can cancel the installation if required, during steps 1 to 4 of Section 2.4
Running the LIS Installation (See page 9).
To cancel the installation, complete the following steps:

Step Action

1 Click Cancel. The Exit Setup dialogue box displays.

2 Click a button:

IF… THEN…

You click Yes The setup programme closes.

You click No The installation programme returns to the
point when Cancel was clicked and
continues the installation.
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3. Uninstalling LIS

3.1 Overview LIS has a facility to allow you to uninstall the software easily. You can begin
the un-installation process in a number of ways:
 use the Uninstall shortcut from the Start menu
 run setup.exe from the installation folder.

3.2 Uninstall
from the Start
Menu

To uninstall LIS 17.03 from your PC using the Uninstall shortcut, complete
the following steps:

Note: you must be logged on with Administrator rights to uninstall the
software.

Step Action

1 Select the Uninstall LIS 17.03 shortcut from Start | Programs |
Learner Information Suite | LIS Maintenance | Uninstall
v17.03.

The Uninstall message appears.
2 Click a button:

IF… THEN…

You click Yes Go to step 3.

You click No The uninstall program terminates.

3 The uninstall program runs. Cancel exits the program. When
complete, the box closes and LIS 17.03 is uninstalled.

3.3 Uninstall
using Setup

To uninstall LIS 17.03 from your PC using setup.exe, complete the
following steps:

Note: you must be logged on with Administrator rights to uninstall the
software.

Step Action

1 Navigate to the setup.exe file used to install LIS 17.03 on your
PC and double-click the file.

The Preparing to Install screen appears. Cancel will exit the
program. Once completed, the Welcome screen displays.

2 Select the Remove radio button and click Next.

The Confirm Uninstall dialogue box displays.
3 Click a button:

IF… THEN…

You click OK Go to step 4.

You click Cancel You return to the Welcome
screen as in step 1.
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4 The Setup Status window appears. Cancel will cancel the un-
installation of LIS 17.03. On completion, the Maintenance
Complete screen displays.

Click Finish.
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4. The Learning Aim Database

4.1 Overview The Learning Aim Database (LAD) is a Data Service application that holds
information on learning aims and associated funding and statistical
information.

This information is used by the LIS and other Data Service systems to
validate ILR data calculate derived variables and calculate funding.

The LAD is available to search online, or you can download an extract of LAD
data. More information about the LAD is available from the LAD pages of the
Data Service website at http://providers.lsc.gov.uk/LAD/default.asp.

4.2 The LAD
and LIS

Because the LIS requires information from the LAD to process data, it is
necessary to create a link between the LIS and a download from the LAD.

The data in the LAD is updated frequently. Regularly download a new
version to ensure you are working with the most current information.

4.3
Downloading
the LAD from
the Website

To download the latest version of the LAD, complete the following steps:

Step Action

1 Browse to the LAD on the Data Service provider extranet:
http://providers.lsc.gov.uk/LAD.

2 Click LAD Downloads in the top menu bar.

The LAD downloads page displays.
3 Click on the file you wish to download. For the LIS you will need a

file in Microsoft Access format (.mdb) file. For LIS 17.03 you can
download either:
 the entire LAD, which contains information for the relevant

teaching year as well as two other years; or
 the LAD for 2009/10

The File Download dialogue box displays.

During steps 3 to 5, Cancel stops the download.
4 Select the Save this program to disk option and click OK.

The Save As dialogue box displays.
5 You may choose to change the location and file name for saving

to your PC. When you have completed this click Save.

The download begins and the Download dialogue box displays.

Continued on next page



Learner Information Suite 17.03 User Guide Version 1
16 April 2010 Page 14 of 89

4. The Learning Aim Database, Continued

4.3 Downloading the LAD from the Website, continued

Step Action

6 On completion of the download, the Open and Open Folder
buttons become available.

IF… THEN…

You click Open The file will be opened for you
to access and unzip to a
suitable location on your PC.

You click Open Folder The folder containing the
downloaded LAD is opened.

You click Close The Download dialogue box is
closed.

7 You will need to unzip the LAD then link it to the LIS.
Refer to Section 7.6 Link to the LAD (See page 29).
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5. Login to LIS

5.1 Overview The LIS can be started from the Start menu or from the shortcut icon on
your desktop. You will need to enter a password to login.

By default when the software is installed onto your PC, the password is set
to “password”. You may need to change the password in line with your
organisation’s security policy.

5.2 Accessing
LIS from the
Start Menu

To access LIS 17.03 from the Start Menu choose Start | Programs |
Learner Information Suite v17.03 | LIS v17.03

5.3 Accessing
LIS from the
Desktop

To access LIS 17.03 from your desktop, double click the LIS v17.03 icon.
This is automatically created as a desktop shortcut during installation.

5.4 Login to LIS To login to LIS 17.03, complete the following steps:

Step Action

1 Start LIS 17.03.

In the Learner Information Suite Login dialogue box, type the
password “password” (in regular font and using lower case,
without the quote marks) into the password field.

Note: If the password has already been changed then use that
password to login.

If you click Cancel, the dialogue box closes and the LIS will not
start.

2 Click Login.

This logs you into LIS and briefly displays a splash screen. The
Welcome screen displays once the application loads.

You have now logged into LIS and can use it.
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5. Login to LIS, Continued

5.5 Changing
your Password

The LIS password can be changed if required.

However, note that:
 if you forget the new password, the LIS software must be uninstalled

and then re-installed to set the password back to the default setting of
“password”

 each time you upgrade the LIS software the password will be re-set to
“password”.

To change the password, complete the following steps:

Step Action

1 Start LIS 17.03.

In the Learner Information Suite Login dialogue box, enter your
current password into the password field.

2 Click the Change checkbox.

3 Click Login.

The Change Password dialogue box appears.
4 Enter a new password into both the New Password field and

the Verify Password field.

The new password and verify password fields must match.
5 Click OK.

IF… THEN…

The passwords match Continue to step 6.

The passwords do not
match

An error message will appear.
Click OK and go back to step
4.

6 The Welcome screen displays. The password has now been
changed and you may start to use LIS.
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6. Navigating Around LIS

6.1 Overview To navigate around and access the LIS screens, you have two options:
 menu bar
 Navigation tree.

6.2 Navigation
using the Menu
Bar

The LIS application menu bar allows you to move around the screens by
selecting a menu option and then clicking the required item.

All types of collection - ASL, ESF SR, LR, UFI and ER - are accessed from
the same menu options. The Batch Import screen allows the collection type
to be selected as well as the collection itself. Refer to Section 7.4 Change
the Collection Type (See page 25).

6.3 Navigating
the File Menu

The following step shows the File menu option:

Step Action

1 Click File. You can also use Alt-F to access the File menu.

There is only one option available, Exit.

Selecting the Exit option will close the LIS. You can also use
in the top right hand corner of the application window to

close the application.

6.4 Navigating
the View Menu

The following steps show the View menu option:

Step Action

1 Click View. You can also use Alt-V to access the View menu.

The following options are available:
 ILR Data Viewer
 ER Funding Viewer
 LR Funding Viewer

Continued on next page
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6. Navigating Around LIS, Continued

6.4 Navigating the View Menu, continued

Step Action

2 From within the View menu, select ILR Data Viewer.

The ILR Data Viewer screen displays. This screen allows you
to:

 search for specific learners
 view details for a selected learner from the imported ILR

data
 view rule violations for the selected learner
 link to Report Manager with the learner reference filter pre-

populated.
Note: The ILR Data Viewer is highlighted within the Navigation
tree

3 From within the View menu, select ER Data Funding Viewer.

The ER Funding Viewer screen displays. This screen allows
you to view imported and calculated data by:
 searching for specific learners
 viewing details for a selected learner from the imported ILR

and LAD data
 viewing details for a selected learner from the calculated

derived variables and ER funding data
 viewing rule violations and calculation errors for the

selected learner.
Note: The ER Funding Viewer is highlighted within the
Navigation tree Funding Viewer.

4 The LR Funding Viewer screen displays. This screen allows
you to view imported and calculated data by:
 searching for specific learners

 viewing details for a selected learner from the imported ILR
and LAD data

 viewing details for a selected learner from the calculated
derived variables and LR funding data

 viewing rule violations and calculation errors for the
selected learner.

Note: The LR Funding Viewer is highlighted within the
Navigation tree
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6. Navigating Around LIS, Continued

6.5 Navigating
the Data Menu

The following steps show the Data menu option:

Step Action

1 Click Data. You can also use Alt-D to access the Data menu.

The following options are available:
 Batch Import
 Export ILR File
 Calculate Funding Data
 Calculate Derived Data
 Reconciliation
 Delete reconciliation data

2 From within the Data menu, select Batch Import.

The Batch Import screen displays. The Batch Import screen
combines most of the functionality of the LIS into a single
screen. It allows you to:
 select a provider
 select the correct collection type and collection period
 link to the LAD
 import ILR data
 validate ILR data
 calculate ER or LR funding data, as appropriate for

collection type and collection period
 calculate derived data
 add and delete files for import
 export ILR data
 export the LIS database (DB) and select the format
 run DSAT software and select the DSAT location
 run and print reports
 save and load defaults
 monitor the status of batch operations.
 start and cancel the import process

Note: The Batch Import is highlighted within the Navigation
tree

3 From within the Data menu, select Export ILR File.

The Export ILR File screen displays. This screen allows you to:
 change the export area path
 export ILR data to a file
 select data type when exporting the ILR data
 save and load defaults
 cancel the export

Note: The Export ILR File is highlighted within the Navigation
tree

Continued on next page



Learner Information Suite 17.03 User Guide Version 1
16 April 2010 Page 20 of 89

6. Navigating Around LIS, Continued

6.5 Navigating the Data Menu, continued

Step Action

4 From within the Data menu, select Calculate Funding Data.

The Calculate Funding Data screen displays. This screen
allows you to:
 run the LR funding calculations on your ILR data, as

appropriate for collection type and collection period
 run the ER funding calculations on your ILR data, as

appropriate for collection type and collection period
 View the progress of each part of the calculation process
 cancel the calculation

Note: The Calculate Funding Data is highlighted within the
Navigation tree

5 From within the Data menu, select Calculate Derived Data.

The Calculate Derived Data screen displays. This screen
allows you to:
 run the derived data calculations on your ILR data
 cancel the calculations

Note: The Calculate Derived Data is highlighted within the
Navigation tree

6 From within the Data menu, select Reconciliation
The Reconciliation screen displays. This screen allows you to:
 change Provider 1 and Provider 2 details, as appropriate
 select the mode
 reconcile two ILR files to check that continuing learners

from the earlier file are present in the later file as expected
 export a reconciliation file for transmission to the Data

Service
 run the Reconciliation report

Note: The Reconciliation is highlighted within the Navigation
tree

7 From within the Data menu, select Delete Reconciliation
Data.

The Delete Reconciliation Data dialog displays. This screen
allows you to:
 delete any previous reconciliation data.
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6. Navigating Around LIS, Continued

6.6 Navigating
the Reports
Menu

The following steps show the Reports menu option:

Step Action

1 Click Reports. You can also use Alt-R to access the Reports
menu.

There is only one option available, Report Manager.
2 From within the Reports menu, select Report Manager.

The Report Manager screen displays. This screen allows you
to:
 view the available reports, select as appropriate
 run selected reports, with filters if required
 view the output on screen and print the selected reports
 export selected reports
 export the LIS database (DB) / lookup tables.

Note: The Reports Manager is highlighted within the
Navigation tree

6.7 Navigating
the General
Menu

The following steps show the General menu option:

Step Action

1 Click General. You can also use Alt-G to access the General
menu.

The following options will be available:
 Validation Rules
 Log
 Options
 Postcodes

2 In the General menu, select Validation Rules.

The Validation Rules screen displays. This screen allows you
to:
 view the list of validation rules used by the LIS for validating

ILR data
 view detailed descriptions for rules in the list, including the

severity level.

Note: The list contains all the rules used for validation for all
collection types. The Collections column (Colls) displays
categories that identify the collection type the rule is applied to.
Refer to Section 15 Validation Rules (See page 72)

Note: The Validation Rules is highlighted within the Navigation
tree
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6. Navigating Around LIS, Continued

6.7 Navigating the General Menu, continued

Step Action

3 From within the General menu, select Log.

The Log screen displays. This screen enables you to:
 view a log of all operations carried out by the software

since the log was last cleared.

Operation details include Date & Time, Module, Function and
Messages, which are listed in ascending date order e.g. the
most recent details are at the bottom of the list. Use the
vertical scrollbar if required to view most recent results.

Note: The Log is highlighted within the Navigation tree.
4 From within the General menu, select Options.

The Options screen displays, with the following tabs available:
 Status Information
 Maintenance
 Import Errors
 Version Information

From within the Status Information tab, you can view:
 view status information for the each ILR Batch Import

process
 view a summary count of learners, aims and dataset types

From within the Maintenance tab, you can view:
 select a provider
 truncate the log file
 clear any locked interrupted processes in the database
 compact the database
 update the provider lists data .
 update the link to Postcode Factors

From within the Import Errors tab, you can view:
 view import errors

From within the Version Information tab, you can view the
current version information for the:
 LIS
 linked-to LAD
 Module Versions (LR /ER Funding Calculations, DLF

Common and Derived Data Calculation)
 Lookup Tables (Providers, Postcodes, TtG Broker

Contracts, Postcode Area Cost Factors and Postcode
Disadvantage Factors).

Note: The Options is highlighted within the Navigation tree
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Step Action

5 From within the General menu, select Postcodes.

This option maintains the 'Outward' postcodes (eg. 'CV1') used
for validation of ILR data and allows extra codes to be added
when a new postcode is created by the Royal Mail.

The Postcodes screen displays. The Postcodes screen allows
you to:
 search for and view the postcodes included in the LIS
 insert new postcodes
 delete postcodes.

Note: The Postcodes is highlighted within the Navigation tree

6.8 Navigating
the Help Menu

The following steps show the Help menu option:

Step Action

1 Click Help. You can also use Alt-H to access the Help menu.

There is only one option available, About Learner Information
Suite.

2 From within the Help menu, select About Learner Information
Suite.

The About Learner Information Suite screen displays. The
About Learner Information Suite screen allows you to:
 view LIS version information
 view system information
 link to the LIS page in the Data area of the Data Service

website:
http://www.thedataservice.org.uk/Services/DataCollection/softw
are/lis/
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6. Navigating Around LIS, Continued

6.9 Navigation
using the
Navigation
Tree

The LIS navigation tree allows you to move around the screens by
expanding and selecting folder items representing the LIS screens.

The options are the same as in the menus, except there is no entry for
Delete Reconciliation Data, as viewed via the Data menu option.

Step Action

1 The navigation tree folders appear on the left hand side of the
Welcome screen. Click on the + symbol to the left of the LIS
2009/10 folder icon to expand the navigation tree.

Note: you can use the button to close the navigation tree
display. To restart the navigation tree you must click on the title
bar, where the screen title is displayed, below the menu
options.

2 The following folders (screens) are available from the
navigation tree:

 Batch Import
 ILR Data Viewer
 Calculate Funding Data
 LR Funding Viewer
 ER Funding Viewer
 Calculate Derived Data
 Export ILR File
 Report Manager
 Validation Rules
 Log
 Options
 Postcodes
 Reconciliation

Click on the required folder, to display the relevant screen.



Learner Information Suite 17.03 User Guide Version 1
16 April 2010 Page 25 of 89

7. Importing and Validating ILR Data

7.1 Overview You can import and/or validate ILR data from the Batch Import screen.

Note: From the Batch Import screen you can choose to run many different
operations, including importing and validating ILR data, running calculations
and reports and exporting ILR data or the LIS database. These operations
can be selected in various combinations.

7.2 Import ILR
Data using
Batch Import

To import and validate ILR data, complete the following steps:

Step Action

1 Access the Batch Import screen:

2 Set up the batch import as described in the following sections.

3 Click the Start button to start the processes selected.

The processes start. Status and progress are displayed.

IF... THEN...

You wish to cancel the
process once it has started.

Go to Section 7.15 Cancel
the Import/Validate Process
(See page 41).

You receive an import error
message.

Go to Section 7.16 What if
the Import Process Aborts
(See page 41).

You receive a confirmation
that the process has
completed successfully.

Click OK and go to your
required next action.
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7. Importing and Validating ILR Data, Continued

7.3 Change the
Provider

The first time you use LIS you will need to select the specific provider
number and name.

Note: If you use more than one provider number for transmitting ILR data
you must ensure the provider field displays the correct provider number and
name for the ILR data you are importing. If the provider number does not
match the provider reference in the ILR file name then the ILR import will
not allow the file to be selected.

To change the provider, complete the following steps:

Step Action

1 Access the Batch Import screen by selecting Batch Import from
the navigation tree.

Click the Change Prov… button.

The Provider Selection window displays:

2 You can select a provider using any of the methods listed below:
 type the first few characters of the name into the Find field.

The list will scroll as you type until the provider name that
matches the characters typed displays.

 search by entering the whole provider number in the Find field.

 use the vertical scroll bar to scroll to your provider name and
number.

Highlight the entry in the list.
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Step Action

3 Click OK, to confirm your selection of provider.

A dialogue box is displayed which requests the deletion of current
provider data. Respond appropriately.

Note: This dialogue box only displays if a previous provider was
selected. If there was no provider selected, the prompt will not
appear.

To close the Provider Selection window, without selecting a
provider, click either Cancel or .

4 Click a button:

IF… THEN…

You want to change the provider
name and delete any data
previously imported for another
provider.

Click Yes.
You return to the Batch
Import screen and the
new provider name and
number displays.

You do not want to change the
provider name and delete any
data previously imported for
another provider.

Click No.

You return to the Batch
Import screen and the
provider is not changed.

Note: You can also change provider details from the Maintenance
Tab of the Options screen by clicking on the Provider… button.

7.4 Change the
Collection Type

The Collection Type field in the Batch Import screen must display the code
for the collection type being imported (ASL, ESF SR, LR, UFI and ER):

Step Action

1 Click the drop down on the Collection Type field to list the
collection types.

2 Click on the collection type required to select it.
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7.5 Change the
Collection
Code

The Collection field in the Batch Import screen must display the code for the
collection being imported:

The collection codes will be automatically displayed relevant to the
collection type selected (for example, for LR the collection codes will be
F01, F02, etc.)

Step Action

1 Click the drop down on the Collection field to list the collection
codes.

Note: If you selected the Collection Type code using:
 ASL, the Collection code will be prefixed with a letter C
 ESF SR, the Collection code will be prefixed with a letter S
 LR, the Collection code will be prefixed with a letter F
 UFI, the Collection code will be prefixed with a letter U
 ER, the Collection code will be prefixed with a letter W.

2 Click on the collection code required to select it.
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7. Importing and Validating ILR Data, Continued

7.6 Link to the
LAD

In order to validate your ILR data you must link LIS to a download from the
LAD. Refer to Section 4.3 Downloading the LAD from the Website section
(See page 13), for details of how to download the LAD tables.

To link LIS to the LAD, complete the following steps:

Step Action

1 Access the Batch Import screen.

If this is the first time you have linked to the LAD, the Learning
Aim Database Version and Location fields will be blank;
otherwise, they will contain details for the previously linked
LAD.

2 Click the Change LAD… button

The Select Learning Aim Database Path window displays.
3 Use the explorer window to navigate to the directory that

contains the most recent version of the LAD MDB.

Select the directory, and click Open.

When you return to the Batch Import screen, the Learning Aim
Database Version and Location fields are now populated /
updated.

To close the Select Learning Aim Database Path window,
without selecting a LAD MDB, click either Cancel or .
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7. Importing and Validating ILR Data, Continued

7.7 Select
Operations

The Select Operations area of the Batch Import screen allows you to select
which processes to run:
 Import ILR Data – this operation checks the ILR data file against import

validation rules, reports on any errors and only imports the file once it
passes all import validation checks.

 Validate Data – this operation validates ILR data against the validation
rules and reports any errors. However, this operation can only run when
the ILR data file has been successfully imported into LIS. You can
select the Type Of Validation by checking the appropriate radio button,
either All Validation Rules or Funding Rule Subset.

 Calculate LR Funding– this operation calculates LR funding data for
each learner that has passed validation. (Note: that the learners do not
need to be fully valid but must be valid according to the funding subset
of the validation rules.) Check box only available for certain collection
types – see table below.

 Calculate ER Funding– this operation calculates ER funding data for
each learner that has passed validation. (Note: that the learners must
be fully valid.) Check box only available for certain collection types –
see table below.

Option
Collection

Type
Calculate LR

Funding
Calculate ER

Funding

Type Of Validation
(Funding Rule/ All

Validation)
ASL

ESF SR

LR
● ●

UFI
● ●

ER ●
 Calculate Derived Data – this operation performs the derived data

calculation, which calculates statistical values for each learner that has
passed validation. (Note: that the learners do not need to be fully valid
but must be valid according to the funding subset of the validation rules.)
This option is only available if the applicable funding calculation has
been run for these learners. These values are calculated and stored in
the LIS database, and also used in some reports.

If all the operations are selected, LIS attempts to import the ILR data file first
and, providing there are no import errors, it then validates the data, derives
the statistical values and calculates funding data.

To select the operations to run, complete the following step:

Step Action

1 Access the Batch Import screen.

Check the Select Operations box(es) for the required
operation(s).

Note: The validation and calculation operations can be run at a
later stage if required without re-importing and validating the
data.
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7. Importing and Validating ILR Data, Continued

7.8 Add ILR
Data File

To add an ILR data file to import, complete the following steps:

Step Action

1 Access the Batch Import screen

IF... THEN...

This is the first time
you are selecting a
file for import

The Import Area and Files
selected to import fields will be
blank. Go to step 3.

You have previously
imported a file.

The import fields will contain those
details. They can be removed
using the Delete Files facility as
described below. Go to step 2.

2 Check the file directory displayed:

IF... THEN...

You want to change
the directory of the
file for import

Go to step 3.

You want to use this
file listed in the
directory.

Go to step 6.

3 Click the Add Files button. The Add ILR File to Batch window
displays.
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Step Action

4 Navigate to the directory that contains the ILR file to be
imported and select the file.

Note: If an incorrect provider, collection type or collection
period have been selected, or if the file is not named correctly,
the files will not be visible.

To close the Add ILR File to Batch window, without selecting a
file, click either Cancel or .

5 Click Open.

You return to the Batch Import screen and the Import Area and
Files selected to import fields display details of the file
selected for import.

Note: If there is any ILR data already present within LIS, it will
be deleted when the new data is imported. LIS uses a copy of
the ILR data file you have selected – the original file is not
affected.

Once the import is completed you can delete the file(s) from the
LIS import area by selecting them and clicking the Delete Files
button.

6 At this stage:

IF... THEN...

You want to import the
selected file, without
choosing Export ILR, DB,
DSAT Options or Selecting
Reports

Click on the Start button to
activate the process.

You want to choose Export
ILR, DB, DSAT Options or
select Reports prior to
importing the selected file

Continue to Section 7.9
Export ILR.
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7. Importing and Validating ILR Data, Continued

7.9 Export ILR Using the Export Options area of the Batch Import screen you can export
the ILR data ready for transmission to the Data Service using Provider
Batch.

Note: The Export ILR feature will export valid ILR data ONLY and any
invalid data WILL NOT be exported. Therefore the export file may not be a
reflection of the full ILR data file originally imported.

To export ILR data to a file for transmission to the Data Service you will
export the file to a folder on your PC. The default location displays after the
Change… button is used. The default location is C:\LIS\Release17\exports.

To export your ILR data to a file, complete the following steps:

Step Action

1 On the Batch Import screen, within the Export Options area,
click on the ILR check box.

IF... THEN...

This is the first time you are
exporting ILR data.

The Change… button will
activate. Go to step 3.

You have previously
exported ILR data.

The Change… button will
activate and the file
directory of the last ILR
export displays. Go to step
2.

2 Check the file directory displayed:

IF... THEN...

You want to change the
directory to which the ILR
data will be exported

Go to step 3.

You want to use this
directory for the ILR export

Go to step 5.
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Step Action

3 Click Change….

The Select ILR Export Path window displays.

4 Use the explorer window to navigate to and select the new
directory for your ILR data export, change the file name (if
appropriate) and click Open.

You will now be returned to the Batch Import screen. The
Export ILR field details the new location of the ILR export.

To close the Select ILR Export Path window, without selecting a
directory or changing the filename, click either Cancel or .

5 The ILR field displays details of the directory selected for the
ILR export.

Note: You can also export to an external drive, if required, by
selecting the external directory location within the Select ILR
Export Path window.

6 At this stage:

IF... THEN...

You want to import the
selected file and export ILR
data, without choosing the
Export DB and DSAT
Options or Selecting
Reports

Click on the Start button to
activate the process.

You want to choose Export
DB and DSAT Options or
Select Reports prior to
importing the selected file
and export ILR data

Continue to Section 7.10
Export DB.

7 After the batch import is complete you can view the exported
ILR data file by opening the file from the directory selected in
step 4 and transmit it to the Data Service using Provider Batch.
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7. Importing and Validating ILR Data, Continued

7.10 Export DB
(database)

Using the Export Options area of the Batch Import screen, the LIS provides
the Export DB function to allow you to view and manipulate the data held
within the internal LIS database.

Note: This does NOT create a file that is suitable to send to the Data
Service. Files sent to the Data Service must be exported using ILR Export.
Refer to Section 7.9 Export ILR (See page 33).

To use the Export DB facility, complete the following steps:

Step Action

1 On the Batch Import screen, within the Export Options area,
click on the Export DB checkbox.

IF... THEN...

This is the first time
you are exporting the
database.

The Change… button will
activate. Go to step 3.

You have previously
exported the
database.

The Change… button will
activate and the file
directory of the last
database export is
displayed. Go to step 2.

2 Check the file directory displayed:

IF... THEN...

You want to change
the directory to which
the database is to be
exported

Go to step 3.

You want to use this
directory for the
database export

Go to step 5.
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Step Action

3 Click Change…

The Select Database Export Path window displays.

4 Use the explorer window to navigate to and select the new
directory for your database export, change the file name (if
appropriate) and click Open.

You will now be returned to the Batch Import screen. The
Export DB field details the new location of the database
export.

To close the Select Database Export Path window, without
selecting a directory or changing the filename, click either
Cancel or .

5 Using the Format drop down list, select the required format
for the database export.

6 At this stage:

IF... THEN...

You want to import the
selected file, export the
ILR data and export the
database, without using
exporting DSAT option or
Selecting Reports

Click on the Start button
to activate the process.

You want to use the
export DSAT option or
choose Selected Reports
prior to importing the
selected file and exporting
the ILR file and exporting
the database

Continue to Section 7.11
Running DSAT.

7 Once the import/validate process is run you are able to view
the data by opening the file from the directory selected in
Step 4.
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7. Importing and Validating ILR Data, Continued

7.11 Running
DSAT

When you export the LIS database as an Access database file you can
automatically run DSAT (Data Self-assessment Toolkit) software to analyse
the data and produce reports. You need to have the DSAT software
installed before this operation will work.

For more information on the DSAT software refer to the DSAT page of the
Data Service website
(http://www.thedataservice.org.uk/Services/DataCollection/software/dsat/).

To run DSAT after exporting the LIS database, complete the following steps:

Step Action

1 On the Batch Import screen click the DSAT checkbox.

IF... THEN...

This is the first time
you are running the
DSAT software

The Change… button will
activate. Go to step 3.

You have previously
run the DSAT
software.

The Change… button will
activate and the file
directory of the last DSAT
export displays. Go to step
2.

Note: This option is only available when the Export DB option
is selected and the export DB Format is Access 97 (MDB).

2 Check the file directory displayed:

IF... THEN...

You want to change
the directory where
LIS will look for the
DSAT software

Go to step 3.

You want to use this
directory

Go to step 5.
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Step Action

3 Click Change…

The Select DSAT Path window displays.

4 Use the explorer window to navigate to and select the
directory where your DSAT export-to file is stored and click
Open.. The naming convention of the DSAT export-to file is
CaaTs (DSAT) v*.** (2000).mde.

You will now be returned to the Batch Import screen. The
DSAT field details the new location of the DSAT software.

To close the Select Database Export Path window, without
selecting a directory or changing the filename, click either
Cancel or .

5 At this stage:

IF... THEN...

You want to import the
selected file, export the
ILR data, export the
database and use the
DSAT software, without
Selecting Reports

Click on the Start button
to activate the process.

You want to choose
Selected Reports prior to
importing the selected file,
exporting the ILR file,
exporting the database
and using the DSAT
software

Continue to Section 7.12
Select Reports.

6 Once the Batch Import is complete DSAT will open
automatically and load the exported LIS database.
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7. Importing and Validating ILR Data, Continued

7.12 Select
Reports

The Select Reports area of the Batch Import screen allows you to select up
to four reports to be automatically produced when the batch process is run.
Refer to Section 12 Running Reports (See page 57) for a list of available
reports and their descriptions.

You can choose to print the reports or save them in one of several formats
e.g. CSV, DBF, Excel, MDB or PDF.

Note: Reports run from the Batch Import with the Format drop down list set
to ‘Print’, are output directly to your default printer. Because of the length of
the reports that may be produced, it is recommended that you only print the
Rule Violations Summary reports or fixed length reports, such as the
Funding Claim Report, from the Batch Import screen.

To select which reports to produce, complete the following steps:

Step Action

1 On the Batch Import screen, click the drop down arrow next
to the first of the Select Reports fields.

The list of available reports displays.
2 Click on the required report.

The selected report displays in the Select Reports field.
3 Repeat steps 1 and 2 for additional reports required (up to a

maximum of four).
4 Click the drop down arrow next to the Format field.

The list of available formats displays.
5 Click on the required format.

IF... THEN...

You select ‘Print’ The report(s) will be sent
directly to the default
printer. Go to step 9.

This is the first time
you have used a
format that is not
‘Print’, e.g. CSV, DBF,
Excel, MDB or PDF).

Click the Change… button
will activate. Go to step 7.

You have previously
used a format that is
not ‘Print’, e.g. CSV,
DBF, Excel, MDB or
PDF).

Click the Change… button
will activate and the file
directory of the last report
location will be displayed.
Go to step 6.
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Step Action

6 Check the file directory displayed:

IF... THEN...

You want to change
the directory where the
report download will
be saved.

Go to step 7.

You want to use the
defaulted directory.

Go to step 9.

7 Click Change…

The Select Report Export Path window displays.

8 Use the explorer window to navigate to and select the new
directory for your report export, change the file name (if
appropriate) and click Open.

You will now be returned to the Batch Import screen. The
report field details the new location of the report export.

To close the Select Report Export Path window, without
selecting a directory or changing the filename, click either
Cancel or .

9 Click on the Start button to activate the report print / report
export process.

10 Once the report print / report export process is complete, you
can retrieve your printout on your default printer / view the
exported report by opening the file from the directory selected
in step 5.
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7. Importing and Validating ILR Data, Continued

7.13 Saving
Defaults

The Save Defaults button allows you to save the selections made on the
Batch Import screen (and other screens where it appears e.g. Export ILR
File).

If you wish to save your selections as defaults, click Save Defaults .

Note: You can overwrite default selections. The next time that you click
Save Defaults it will overwrite existing defaults with the new selections.

7.14 Loading
Defaults

The Load Defaults button allows you to recall previously saved defaults.

Click the Load Defaults button to recall the defaults. The Batch Import
screen displays with defaults loaded.

7.15 Cancel the
Import /
Validate
Process

Click the Cancel button to cancel the process at any time while it is running.

Note: Before the process is started, and after it has run, the button is de-
activated.

7.16 What if the
Import Process
Aborts

The import process will fail if the file does not meet the requirements of the
import validation rules, for example:
 The transmission number in the header does not match the transmission

number in the filename.
 The provider number in the footer does not match the provider number

in the filename.

If you receive an import error dialogue box, complete the following steps:

Step Action

1 Take a note of the error message and click OK.

A second dialogue box displays explaining that the batch
process has been aborted.

2 Click OK.

You return to the Batch Import screen.
3 Use LIS reports to obtain details of the error. Refer to Section

12 Running Reports (See page 57).
4 Correct the error in your local MIS and import a new ILR data

file. Refer to Section 7 Importing and Validating ILR Data (See
page 31).
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7. Importing and Validating ILR Data, Continued

7.17 Check the
Results of the
Selected
Operations

Once you have run the process you are able to check the results of the
operations you selected (if required).

Step Action

1 Access the Log screen.

The Log screen displays. This screen enables you to:
 view a log of all operations carried out by the software

since the log was last cleared.

Operation details include: Date & Time, Module, Function and
Messages, which are listed in ascending date order e.g. the
most recent details are at the bottom of the list. Use the vertical
scrollbar if required to view most recent results.

Note: The Log is highlighted within the Navigation tree.
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8. Viewing ILR Data

8.1 Overview Although you cannot amend any ILR data from within the LIS you can still
view the data and search for learner information.

8.2 Viewing ILR
Data

You can view the imported ILR data using the ILR Data Viewer screen
within LIS.

To view imported data, complete the following step:

Step Action

1 Access the ILR Data Viewer screen.

Note: No ILR data is visible at this stage (e.g. all fields are
blank).

Refer to:
 Section 8.3 Listing All Learner Records (See below)
 Section 8.4 Searching for Learner Records (See page 45).

8.3 Listing All
Learner
Records

To list all the learner records from the ILR Data Viewer screen, complete the
following steps:

Step Action

1
Click on the All Records icon to list all records.

A list displays on the Learner Records tab. The list will show all
imported ILR learner records for you to view.

Note: If you have more than 100 learner records, only the first
100 will display. A message displays to advise you of this fact.
Click on OK to proceed.

You can move through the list using the active navigation

buttons . Vertical and horizontal scroll bars are
available if all the records are not visible, within each tab / sub
tab.

Note: When you are at the start or the end of the list some of
the navigation buttons will be active or inactive accordingly, e.g.
- at the start of the list, the buttons will be displayed as

(first & previous inactive / next & last active)
- at the end of the list, the buttons will be displayed as

(first & previous active / next & last inactive)

You should search by surname or learner reference to return
more specific results. Refer to Section 8.4 Searching for
Learner Records (See page 45).
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Step Action

2 Click on a learner in the list.

You will be able to view the details for the selected learner in
the header fields and tab sections of the ILR Data Viewer
screen. Refer to Section 8.5 Viewing Learner Details (See page
46).

Note: The position of the learner in the current result set will
also be displayed within the ILR Data Viewer screen e.g.
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8. Viewing ILR Data, continued

8.4 Searching
for Learner
Records

You can search for specific imported ILR learner records if required. When
using search within LIS you can use the following wildcards:
 * or % can be used to represent multiple characters and will enable you

to search using partial information (See examples below)
 ? can be used to represent individual characters when searching using

partial information (See examples below)
Note: The placement of the wildcards, can also affect the results returned
Examples:
 Dav*, could return the following surnames – Davidoff, Davey, Davis or

Davies
 *oo*, could return the following surnames – Cooper, Coogan, Windoo

or Wood
 B?ll, could return the following surnames – Ball, Bell or Bull
 B?ll*, could return the following surnames – Balls, Bellway or Bullman

To search for specific ILR learner records, complete the following steps:

Step Action

1 From the Enter Search Text area, use the drop down to select a
search type as either Surname or Learner Ref.

2 Enter a surname or learner reference into the Enter Search
Text field, using wildcards if required.

3
Click to start the search.

IF... THEN...

A match is found The result(s) will be shown in the
Learner Records list.

The search results will display the
number of records matched and
listed. The search is complete.

No match is found An error message displays.

Go to step 4.

4 Click OK and check your search text.

5 Enter a valid search text using steps 1 and 2 to redefine the
search criteria, and use step to 3 to start the search as detailed
above.
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8.5 Viewing
Learner Details

When a learner has been selected from the list, or by using the search
facility, it is possible to view details for the learner, any associated learning
aims and rule violations. This is done using the different tab sections of the
ILR Data Viewer screen. There are two levels of ‘tabs’ and also a header
section showing key information for the selected learner.

Note: For information about the ILR data fields and the validation rules
applied by LIS, please refer to the ILR section of the Information Authority
website at http://www.theia.org.uk/downloads/ilrdocuments/

Note: The position of the learner in the current result set will also be
displayed within the ILR Data Viewer screen e.g.

To navigate around the ILR Data Viewer, complete the following steps:
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8. Viewing ILR Data, Continued

8.5 Viewing Learner Details, continued

Step Action

1 Click on one of the top level data tabs:

The options available are:
 Learners
 Aims and HE
 Rule Violations.

For each data field displayed, to see a description of the field
move the mouse over the field label.

Once one of the tabs has been selected, a sub-set of tabs is
available allowing more data to be viewed for the selected
learner.

2 Click on the tabs, as appropriate.

IF... THEN...

You click on the Learners
tab:

The following options are
available:
Learner Records – a

complete listing of the
Learner’s ILR learner
record

Summaries of ILR field data
by field number:
Learner Details 1
Learner Details 2
Learner Details 3
Learner Details 4

You click on the Aims and
HE tab:

The following options are
available:
 Aim/HE Records – a

complete listing of the
Learner’s ILR aim and
HE records

Summaries of ILR field data
by field number:
 Aim Details 1
 Aim Details 2
 Aim Details 3
 HE Details 1
 HE Details 2.



Learner Information Suite 17.03 User Guide Version 1
16 April 2010 Page 48 of 89

You click on the Rule
Violations tab:

The Rule Violations screen
displays, detailing the
Validation rules that have
been breached for the
selected Learner record.
The following details are
displayed:
 Name
 Description
 Funding
 Warning
 Rule Description
 Field Values
 Validation Expression
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9. Calculating Funding Data

9.1 Overview The funding calculations in the Learner Information Suite implement Demand
Led Funding methodology, it allows:
 LR providers to calculate the LR funding generated by their ILR data,

based upon their validated ILR returns
 ER providers to calculate the ER funding generated by their ILR data,

based upon their validated ILR returns
 the Data Service to use the same algorithms as providers to calculate ER

and LR funding based on the ILR returns transmitted throughout the year.

You can run the funding calculations using either:
 Batch Import screen
 Calculate Funding Data screen.

The LR funding calculation option is not available for ASL, ESF SR or ER files.

The ER funding calculation option is not available for ASL, LR or UFI files.

Before calculating funding, ILR data must be imported and validated. The
funding calculation module uses learners that pass the funding rule subset of
the validation rules, regardless of the type of validation chosen.

To run the funding calculations from the Batch Import screen, Refer to Section
7.7 Select Operations (See page 30). Using the Calculate Funding Data
screen detailed in Section 10.2 Calculating Funding.

Note: When calculating funding within LIS, ensure you are using the latest
provider data tables. The provider data tables contain Provider UPINs,
Provider names, Provider Factors, Additional Learning Support values, Long
Term Residential Statuses. Provider data updates are available to download
from the Data Service website’s LIS page. To update provider data tables
using the downloaded file please refer to Updating your LIS Data (See page
78).

Differences in funding calculation results between LIS and Online Data
Capture (OLDC) usually arise due to one of the following situations:
 Changes to the LAD between the live LAD (used by Online Data Capture)

and the downloaded version linked to the local LIS.
 The version of the LIS being used locally is not the most recent for the

teaching year.
 The LIS calculates funding for all learners who are funding rule valid.

Provider Batch only calculates funding for fully valid learners.
 The ILR file run through LIS is different from the file sent to the portal.
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9. Calculating Funding Data, Continued

9.2 Calculating
Funding

To calculate funding, first import and validate your ILR data file, then
complete the funding calculation, by following the steps listed below:

Step Action

1 Access the Calculate Funding Data screen.

2 Click Calculate LR or Calculate ER. The LIS runs the funding
calculation stages:
 Export learner and aim data
 Export calculations, lookups and census dates
 Calculate funding
 Import calculation results
 Import calculation variables
 Import calculation errors

Click Cancel to abort the calculation while it is in progress.
3 On successfully completing the calculations, a confirmation

message displays.

Click OK to acknowledge the message. The calculations are
complete.
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10. Deriving Data

10.1 Overview LIS 17.03 contains the derived data calculations. Derived data (derived
variables) are calculated for several reasons:

 They are used by the LIS in the preparation of reports and for the
funding calculations.

 They allow consistency of definitions between the Data Service and
providers.

 Providers can use the derived variables for their own reporting
purposes.

The derived data function can only be run if the funding calculation has
preceded it. The Calculate Derived Data option on the batch import screen
will only become active if ‘Calculate LR Funding’ or ‘Calculate ER Funding’
has already been selected.

Only valid learners are passed to this module. LR, UFI and ER learners can
be validated against the funding subset of the validation rules. All other
learner types must be fully validated.

10.2 Calculating
Derived Data

To run the derived data calculations outside of the Batch Import process,
complete the following steps:

Step Action

1 Access the Calculate Derived Data screen.

Click Derive Data to run the derived data calculation.

Click Cancel to abort the calculation while it is in progress.
2 On successfully completing the calculations, a confirmation

message displays

Click OK to acknowledge the message. The calculations are
complete.
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11. Viewing Funding Data

11.1 Overview There are several ways to view the results of the funding calculation:

 Use either the LR Funding Viewer or ER Funding Viewer screens
 Run funding reports
 Examine the funding tables in an export of the LIS database.

There are various funding reports to choose from that show different
summaries of funding data. They are described in Section 12 Running
Reports (See page 57).

11.2 Listing All
Funding Data

You can list the funding data for all imported learners.

To list all the data from either the LR Funding Viewer or ER Funding Viewer
screens, complete the following steps:

Step Action

1 Access the LR Funding Viewer or ER Funding Viewer screen as
appropriate

A warning message will be displayed if you select the incorrect
Funding Viewer for your imported learners.

No learner data is visible at this stage.
2

Click on the All Records icon to list all records.

A list displays on the Learners Records tab. The list will show all
imported ILR learner records for you to view.

Note: If you have more than 100 learner records, only the first
100 will display. A message displays to advise you of this fact.
Click on OK to proceed.

You can move through the list using the active navigation buttons

. Vertical and horizontal scroll bars are available if
all the records are not visible, within each tab / sub tab.

Note: When you are at the start or the end of the list some of the
navigation buttons will be active or inactive accordingly, e.g. - at

the start of the list, the buttons will be displayed as
(first & previous inactive / next & last active)
- at the end of the list, the buttons will be displayed as

(first & previous active / next & last inactive)

You should search by surname or learner reference to return
more specific results. Refer to Section 8.4 Searching for Learner
Records. (See page 45).
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Step Action

3 Click on a learner in the list.

You will be able to view the details for the selected learner in the
header fields and tab sections of the Funding Viewer screen.
Refer to Section 11.4 Viewing Funding Data (See page 55).

Note: The position of the learner in the current result set will also
be displayed within the ILR Data Viewer screen e.g.
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11.11. Viewing Funding Data, Continued

11.3 Searching
for a Learner’s
Funding Data

You can search for funding data for a specific learner if required. When
using search within LIS you can use wildcards. * will enable you to search
using partial information. ? can be used to represent individual characters
when searching using partial information. Refer to Section 8.4 Searching
for Learner Records for more details regarding the use of wildcards (See
page 45)

To search for the funding data for a specific learner, complete the following
steps:

Step Action

1 From the Enter Search Text area, use the drop down to select a
search type as either Surname or Learner Reference.

2 Enter a surname or learner reference into the Enter Search Text
field, using wildcards if required.

3
Click the to start the search.

IF... THEN...

A match is found The result(s) will be shown in the
Learner Records list.

The search results display the number
of records matched and listed. The
search is complete.

No match is found An error message displays.

Go to step 4.

4 Click OK and check your search text.

5 Enter a valid search text using steps 1 and 2 to redefine the search
criteria, and use step to 3 to start the search as detailed above.
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11.4 Viewing
Funding Data

The Funding Viewer screen has a series of tabs, with different sub-sets of
data. The tabs available depend on which Funding Viewer is used (ER or
LR). Key information is displayed in the header section. All information is
read-only.

To navigate around the Funding Viewer screen, complete the following
steps:

Step Action

1 Click on one of the tabs:
 Learners
 Aims
 Lookups
 SLN (within the LR Funding Viewer) / SLN Inst (within the ER

Funding Viewer)
 Cash
 Calculation Variables
 Errors

2 Once a tab has been selected, a further subset of tabs allows
more data to be viewed.

IF… THEN…

You click on the
Learners tab

A list of learner records is
available. Data displayed by
Learner Data Set field Reference
Number

You click on the Aims
tab

Aim details for the selected
learner are available. Data
displayed by Learning Aim Data
Set field Reference Number

You click on the
Lookups tab

Funding details from the LAD
about the learning aims are
available.

You click on the SLN
tab – only available on
the LR Funding Viewer

The following options are
available:
 Aim SLN (Inc E2E) tab: This

shows the annualised SLN for
the aim and the start period,
in which it is awarded.

 E2E Programme SLN tab:
This shows the amount of
SLN calculated by the LIS for
each period of active learning.

 E2E Bonus SLN tab: This
shows the E2E Bonus SLNs
generated by the learner’s
activity and the period(s) in
which they occur.

 Summary tab: This shows a
sum of the previous three
groups spilt by period.
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You click on the SLN
Inst tab – only available
on the ER Funding
Viewer

 On Programme SLN Inst tab:
This is the amount of SLN
calculated by the LIS in
instalments for each period of
active learning.

 Achievement SLN Inst tab:
This shows the Achievement
SLN and the period in which it
is awarded.

 Balancing SLN Inst tab: When
a learner achieves before the
planned end date then a
remaining balance of on-
programme SLN instalments
still need to be awarded. This
tab shows details that where it
exists.

 Totals tab: This shows a sum
of the previous three groups
spilt and summed by period.

You click on the Cash
tab in the LR Funding
Viewer

The following values are shown in
a table arranging aim values and
with totals by period:
 Programme Cash (£).
 ALS (£).
 Totals (£).

You click on the Cash
tab in the ER Funding
Viewer

The following values are shown in
a table arranging aim values and
with totals by period:
 On Programme (£).
 Achievement (£).
 Balancing (£).
 ALS (£).
 Totals (£)

You click on the
Calculation Variables
tab

This screen shows the steps in
the funding calculation for the
learner selected.
It displays the following LIS mdb
fields:
 LRFundingAim table (within

the LR Funding Viewer
screen)

 ERFundingAim table (within
the ER Funding Viewer
screen)

You click on the Errors
tab

This screen shows any Rule
Violations or Funding Calculation
Errors for the learner selected.
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12. Running Reports

12.1 Overview You can run reports from the:
 Batch Import screen
 Report Manager screen.

For running reports from the Batch Import screen refer to Section 7.12 Select
Reports (See page 39).

The Batch Import screen will output reports directly to a printer or export as a
file e.g. CSV, DBF, Excel, MDB or PDF. Whereas the Report Manager screen
will output to a window for viewing, printing or exporting to either Excel or
PDF format.

Continued on next page
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12.2 Available
Reports

The following validation reports are available for all collection types, and can
be both run and exported from within the LIS.

The first four violations reports include a summary box which details the total
number of data records, the total number of invalid and valid learners
according to rule type (full or co-funding-only) and a count of the aims for each
funding stream value. (This count is based on ILR field A10.)

Report
Ref

Name Report Description

1 Rule Violations Lists any ILR rule violations produced during
the validation process.

2 Rule Violations
by LSC

Lists any ILR rule violations produced during
the validation process, grouped by local LSC
(LLSC).

3
Rule Violations
Summary

Outputs, for each validation error generated
during the validation process, a count of the
number of instances found in the ILR data.

4
Rule Violations
Summary by
LSC

Outputs, for each validation error generated
during the validation process, a count of the
number of instances found in the ILR data,
grouped by local LSC (LLSC).

5
Full ILR
Validation Rules

Lists all ILR validation rules used by the LIS.

6
Future Funding
Factors

Shows predicted funding factors based upon
the currently imported ILR data file.

7
ULN Credibility
Report

This report identifies potential cases where the
same Unique learner number (ULN) may have
been used for two learners.

8
Employer
Reference
Summary Report

This report shows a count and percentage the
of each value of Employer Reference (field
A44) in the imported ILR file.

10
ER Detailed
Learner and Aim
Funding

Shows selected ILR data and funding totals for
each learner and their associated learning
aims.

11
Summary of ER
DLF by Learner

Summarises funding for every learner
reference.

12

Summary of
Employer
Responsive
Funding

Shows a summary of funding for a provider by
Funding Line category, Cash values, SLN
values and totals by period.

13

ER Indicative
Volume and
Cash Summary
by LSC

This report shows a breakdown of funding and
volumes by programme type, framework code,
SSA types and LSC Code.

14 ER Indicative
Occupancy List

This export enables users to use their imported
ILR data to analyse an indicative occupancy
list.

15

ER Indicative
Volume and
Cash Summary
by Category

This report shows a breakdown of funding and
volumes by programme type, framework code,
SSA types and LSC Code.

Continued on next page
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Report
Ref Name Report Description

16

ILR Actuals by
SSoA Category
(Employer
Responsive)

This report shows summary of Employer
Responsive data, corresponding to the
categories used in the Summary Statements of
Activity produced during the funding allocation
process.

17
ER DLF
Calculation
Variables

This export is comprised of the fields in the
ERFundingAim table from the LIS database
which stores results from the funding
calculation.

18
ER DLF
Calculation
Errors

This report outputs a summary report for all
funding calculation errors in the ILR file.

19
ER Learner
Export

This shows, for every learner, key
variables for funding and categorisation of
Employer Responsive provision.

20 ER Aim Export
This shows, for every aim, key variables
for funding and categorisation of Employer
Responsive provision.

21 ER ILR Form
Report

This outputs a populated ILR with data from
the imported ILR file.

30
LR Detailed
Learner and Aim
Funding

Shows selected ILR data and funding totals for
each learner and their associated learning
aims.

31
Summary of LR
DLF by Learner

Summarises funding for every learner
reference.

32

Summary of
Learner
Responsive
Funding

Shows a summary of funding for a provider by
Funding Line category by fully or co-funded
status, Cash values, SLN values and totals by
period.

33
LR Volume and
Cash Summary
by Aim

This shows the total funding for a provider
classified by period, category and
separates the funding calculated purely for
disadvantage uplift.

35 LR Funding
Claim Report

This report shows learner numbers and
funding by categories used to monitor Learner
Responsive funding.

36

ILR Actuals by
SSoA Category
(Learner
Responsive)

This report shows summary of Learner
Responsive data, corresponding to the
categories used in the Summary Statements of
Activity produced during the funding allocation
process.

37

LR Funding
Included and
Excluded by ILR
Export

This report shows the value of LR records that
are not fully valid but which generate funding
and would not be included in an exported ILR
data file.

Continued on next page
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Report
Ref Name Report Description

38
LR DLF
Calculation
Variables

This export is comprised of the fields in the
LRFundingAim table from the LIS
database which stores results from the
funding calculation

39
LR DLF
Calculation
Errors

This report outputs a summary report for
all funding calculation errors in the ILR file.

40 LR Learner
Export

This shows, for every learner, key
variables for funding and categorisation of
Learner Responsive provision.

41 LR Aim Export
This shows, for every aim, key variables
for funding and categorisation of Learner
Responsive provision.

42 Access to HE
Report

This report summarises Access to HE
provision, and is intended to assist colleges
making returns to AVAs.

43

Summary of LR
Funding for E2E
and 16-18
Learners by LSC

This report shows, by LSC and overall totals,
LR funding for learners on E2E provision and
other 16-18 year old learners for each period.

44 LR ILR Form
Report

This outputs a populated ILR with data from
the imported ILR file.

60
Missing From
Later Return

This report shows the learners identified by the
cross-year reconciliation process as being
expected but not appearing the later ILR file.

70
ACL Learner
Export

This shows, for every learner, key
variables for categorisation of ACL
Responsive provision.

71 ACL Aim Export
This shows, for every aim, key variables
for categorisation of ACL Responsive
provision.

72 ESF ILR Form
Report

This outputs a populated ILR with data from
the imported ILR file.
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12.3 Selecting
and Running a
Report

The Report Manager enables you to select, run, print and export available
reports.

You can only run a single report at a time from Report Manager. If you
would like to run multiple reports simultaneously you should use the Batch
Import screen. Refer to Section 7.12 Select Reports (See page 39).

To use Report Manager to select and run a report, complete the following
steps:

Step Action

1 Access the Report Manager screen.

2 From within the Available Reports section of the screen, select
the report you require from those listed, by clicking on the
relevant row. Upon selection the report will be highlighted.

Note: Within the Filters section of the screen, a selection of
available filters will be displayed. The filters displayed will vary
dependant upon the report selected.

For more details on filters, see Section 12.8 Using Filters in
Reports (See page 62).

3 Click on the Run Report button. The report output displays in a
print preview window.

The toolbar at the top of the report window enables you to:
 Zoom the view and navigate through the report pages.

 Print or export the report output.

Refer to:
 Section 12.12 Printing a Report (See page 66)
 Section 12.13 Exporting a Report (See page 68).
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12. Running Reports, Continued

12.4 Using
Filters in
Reports

Filters are used to restrict the amount of data returned in the report. They
are used when you are interested in a specific record or group of records.
The filters vary for each report and are displayed when a report is
highlighted in the list.

There are no limitations on the number of filters you can use per report, e.g.
you can use no filters or any combination of the available filters.

The only exception to this rule is the Learner Reference filter, which is
mandatory when running either the LR ILR Form Report or the ER ILR Form
Report.

However, the values used should be valid or your report output will be
affected. It is useful to use filters when reporting on large sets of data.

You may use wildcards (*, % or ?) when populating filter fields. Refer to
Section 8.4 Searching for Learner Records for more details regarding the
use of wildcards (See page 45)

Note: Filtered reports can also be run using the print icon from the ILR Data
Viewer screen, which will pre-populate the relevant filters in the Report
Manager screen with the information for the selected learner.
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12.5 Available
Filters for
Reports

There are a number of filters available for use when running reports. The
filters vary from report to report. The following table shows a list of reports
which don’t use filters, and which filters are available for each those that do:

Available Filters
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1 Rule Violations y y y y y y y y

2 Rule Violations by LSC y y y y y y y y

3 Rule Violations Summary y y

4 Rule Violations Summary by
LSC

y y

5 Full ILR Validation Rules y y y

6 Future Funding Factors y

7 ULN Credibility Report y y

8
Employer Reference
Summary Report

y

10
ER Detailed Learner and Aim
Funding y y y

11
Summary of ER DLF by
Learner y y y

12 Summary of Employer
Responsive Funding

y

13 ER Indicative Volume and
Cash Summary by LSC

y y y y

14 ER Indicative Occupancy List y y

15
ER Indicative Volume and
Cash Summary by Category y y y y

16
ILR Actuals by SSoA
Category (Employer
Responsive)

y

17 ER DLF Calculation Variables y

18 ER DLF Calculation Errors y y

19 ER Learner Export y y y

20 ER Aim Export y y y y y

21 ER ILR Form Report y

30 LR Detailed Learner and Aim
Funding

y y y

31 Summary of LR DLF by
Learner

y y y

32 Summary of Learner
Responsive Funding

y y y y

33
LR Volume and Cash
Summary by Aim

y y y

35 LR Funding Claim Report y

36
ILR Actuals by SSoA
Category (Learner
Responsive)

y

37 LR Funding Included and
Excluded by ILR Export

y y y y

38 LR DLF Calculation Variables y



Learner Information Suite 17.03 User Guide Version 1
16 April 2010 Page 64 of 89

R
e

po
rt

R
e

f

N
a

m
e

L
ea

rn
in

g
A

im
R

ef
e

rn
ce

(A
09

)

N
a

tio
n

al
L

ea
rn

in
g

A
im

M
o

ni
ito

ri
ng

(A
48

a)

N
a

tio
n

al
L

ea
rn

in
g

A
im

M
o

ni
ito

ri
ng

A
4

8b

A
w

ar
di

ng
_B

od
y_

C
od

e

C
a

lc
E

rr
o

rC
od

e

F
u

nd
in

gR
u

le

L
ea

rn
er

R
ef

er
en

ce
N

u
m

b
er

(L
03

)

L
S

C
n

um
be

r
of

fu
n

gd
in

g
L

S
C

(L
25

)

P
ro

vi
de

rS
pe

ci
fie

d
Le

ar
ne

r
D

a
ta

(L
42

a)

P
ro

vi
de

rS
pe

ci
fie

d
Le

ar
ne

r
D

a
ta

(L
42

b)

U
n

iq
ue

Le
ar

ne
r

N
um

be
r

(L
45

)

N
a

m
e

P
er

io
d

R
u

le
N

am
e

W
ar

n
in

g

N
o

fil
te

rs

39 LR DLF Calculation Errors y y

40 LR Learner Export y

41 LR Aim Export y

42 Access to HE Report y

43
Summary of LR Funding for
E2E and 16-18 Learners by
LSC

y y y y y

44 LR ILR Form Report y

60 Missing From Later Return y

70 ACL Learner Export y

71 ACL Aim Export y

72 ESF ILR Form Report 1
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12. Running Reports, Continued

12.6
Recommended
Field Values for
Filtering

The following table describes the valid values you can use for each of the
filter fields in the reports:

Filter Name Acceptable Value
Learner Reference Uses the full Learner Reference Number or a partial

Learner Reference Number when using a wildcard
Rule Name Uses the full Rule Name listed on the Validation Rules

screen (Refer to Section 15.2 Listing All Validation Rules,
page 72), or a partial Rule Name when using a wildcard

Funding Rule Can use either Y or N depending upon if you are filtering
for an FE funding rule or not. Y returns results where the
rule is a funding rule; N returns results where the rule is
not a funding rule.

Warning Can use either Y (for warnings) or N (for errors).
Provider Specified Learner Data (1) Uses a reference number or part of one. (Refer to the

ILR Field Specification document, which describes the
use of this field, L42.)

Provider Specified Learner Data (2) Uses a reference number or part of one. (Refer to the
ILR Field Specification document, which describes the
use of this field, L42.)

Provider Specified Aim Data (1) Uses a reference number or part of one.
(Refer to the ILR Field Specification document, which
describes the use of this field, A48.)

Provider Specified Aim Data (2) Uses a reference number or part of one.
(Refer to the ILR Field Specification document, which
describes the use of this field, A48.)

Period Period 1 to 12, where August = Period 1, September =
period 2; etc.

Error code Calculation error code.
Learning Aim Reference Uses the full Learner Aim Reference or a partial Learner

Aim Reference when using a wildcard
LLSC Number The LSC number associated with the learner in ILR field

L25.
Name The validation rule name, allows specific validation rules

to be selected for the report.
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12. Running Reports, Continued

12.7 Running
Filtered
Reports

To use filters in your report, complete the following steps:

Step Action

1 Access the Report Manager screen.

2 Select the required report from the Available Reports list.

3 If you want to remove all values entered in the filter fields of the
report, click the Clear Filters button.

4 Against your required filter, enter a valid value in the filter field.
Repeat for as many filters as required.

5 Click the Run Report button. The report output displays in a
print preview window.

The report output can now be printed or exported. Refer to
Section 12.12 Printing a Report (See page 66) or Section 12.13
Exporting a Report (See page 68) for further details.

12.8 Printing a
Report

You can print reports using:
 Batch Import screen
 Report Manager.

When you choose to print reports from the Batch Import screen, the report
output is sent direct to the default printer. This should be used with caution
as some reports are several hundred pages long.

When using Report Manager, the report output displays on screen first and
then you can send the report to print if required.

Reports can also be exported and printed using another application.
Exported reports can be saved for printing at a later date. Refer to Section
12.13 Exporting a Report (See page 68)

Refer to Section 7.12 Select Reports (See page 39) to print reports from the
Batch Import screen. The following steps describe how to print your report
from within Report Manager screen.

Step Action

1 From within the Report Manager screen, select a report, set
any required filters and click the Run Report button.

The report output displays in the print preview window.
2 Click Print from the top of the report output window. The

Print dialogue box displays.

Select the printer, the print range for the number of pages to
print, and the number of copies required and ensure the collate
copies option is correctly set, if available.
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Step Action

3 Click OK. The report output is printed at the chosen printer.

Click Cancel to close the print dialogue box and not print the
output.
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12. Running Reports, Continued

12.9 Exporting
a Report

It is possible to export report outputs to a variety of formats, depending on
the method used.

Refer to Section 7.12 Select Reports (See page 39) to export reports from
the Batch Import screen.

The following steps describe how to export your report from within Report
Manager screen:

Step Action

1 From within the Report Manager screen, select a report, and
set any required filters

2

IF... THEN...

You wish to export your
report in either Excel or
PDF formats

Go to Step 3.

You wish to export your
report in either csv, dbf or
mdb formats

Go to Step 7.

3 Click the Run Report button, and the report output displays in
the print preview window.

4
Click Export from the top of the report output window.
The Export dialogue box appears.

5 Select either the Excel or PDF format from the drop down list.
The Save As windows displays.

6 If appropriate, use the explorer window to navigate to, and
select a new directory location for your report export. Change
the file name, as required.

To close the Save As window, without selecting a directory
location or changing the filename, click either Cancel or .

Click Save, and you will now be returned to the report output
screen. Go to Step 10.

7 Click the Export button.

The Export Options dialogue box displays.
8 If appropriate, use the explorer window to navigate to, and

select a new directory location for your report export. Change
the file name, as required.

You should also select the format of the exported report, using
the drop down list. Available formats are csv, dbf and mdb.
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Step Action

9 Click Save.

To close the Export window, without selecting a directory or
changing the filename, click either Cancel or . A message is
displayed stating the export has been cancelled.

10 The report will be exported to the specified location. You can
view the report from that location by accessing the exported
report file using Windows Explorer or an appropriate
application.
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13. Exporting ILR Data

13.1 Overview This facility exports the ILR data ready for transmission to the Data Service
using the Provider Batch capture process.

To export your ILR data from LIS you can use the:
 Batch Import screen
 Export ILR File screen.

Note: The Export ILR file feature will export valid ILR data ONLY. Invalid
records WILL NOT be exported. The export file may not be a reflection of
the originally imported ILR data file.

It is therefore important that you ONLY export the ILR data when all errors
have been corrected and the file has been fully validated through the LIS.

The Batch Import screen allows you to select an operation to export
validated ILR data as part of the import/validate process, or separately.
Refer to Section 7.9 the Export ILR (See page 33).

13.2 Exporting
ILR Data using
ILR Export

You can export ILR data using the Export ILR File screen.

The user can choose the export file path.

To export ILR data using the Export ILR File screen, complete the following
steps:

Step Action

1 Access the Export ILR File screen.

The fields on this screen are mainly read-only. They are
populated with information from the imported file.

2 You may choose to change the Data Type by selecting one of
the radio buttons e.g. Live or Test. This will be set by default
from the imported data file.

Continued on next page
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13. Exporting ILR Data, Continued

Step Action

3

IF... THEN...

This is the first time you are
exporting an ILR file

The Export Area path will
be blank. Go to step 5.

You have previously
exported an ILR file

The Export Area path will
be populated with your last
export location. Go to step
4.

4

IF... THEN...

If you want to use the
location within the Export
Area path.

Go to step 7.

If you want to change the
directory location within the
Export Area path.

Go to step 5.

5 Click the Change… button

The Select Export File Path window displays.
6 Use the explorer window to navigate to your required export

location. Select an Export Area path, change the file name (if
appropriate) and click Open.

To close the Export window, without selecting a directory or
changing the filename, click either Cancel or .

7

IF... THEN...

You would like to run the
report showing funding
included and excluded by
the export

Click the Run report
showing funding included
and excluded by ILR
export check box.

You would like to load
defaults

Click the Load defaults
button.

You would like to save
defaults

Click the Save defaults
button.

8 Click on the Export button.

The export begins and a confirmation prompt appears.
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14. Validation Rules

14.1 Overview LIS uses a set of validation rules, in conjunction with the LAD and other
lookup data, to validate the imported ILR data. Using LIS series 17, your ILR
data will be validated against a version of the 2009/10 validation rules.

You can find out which version of the validation rules are used (Refer
Section 16.9 Viewing Version Information (See page 79).

For details about the validation rules and the amendments since previous
releases, please refer to the ILR pages of the Information Authority website:
http://www.theia.org.uk/downloads/ilrdocuments/

14.2 Listing all
Validation
Rules

It is possible to list all the validation rules applied by the LIS by accessing
the Validation Rules screen.

To list all the validation rules, complete the following steps:

Step Action

1 Access the Validation Rules screen.

2 Use the scroll bar to move up and down the list and view the
rules.

14.3 Viewing
Validation Rule
Properties

You can view additional information for each validation rule listed in the
Validation Rules screen.

To view properties for a selected validation rule, complete the following
steps:

Step Action

1 Scroll the list to find the rule you are searching for and double
click the rule.

The Validation Rule Properties dialogue box displays,
detailing the following fields:
 Rule ID
 Rule Name
 Description
 Expression

2 Once you are finished, click Cancel or .

The dialogue box closes and returns to the Validation Rules
screen.

14.4 Reports
showing Full
ILR Validation
Rules

You can view a list of all the ILR validation rules by running the Full ILR
Validation Rules report, which lists the validation rules currently in the LIS.
To run this report, follow the procedure described in Section 12 Running
Reports (See page 57).
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15. Maintaining LIS Options

15.1 Overview There are several options which may need to be viewed and/or maintained
from within the LIS. These options are accessed from the Options screen,
and are displayed as the following four tabs:

 Status Information
 Maintenance
 Import Errors
 Version Information

15.2 Viewing
Status
Information

You can view status information for the data you have imported into LIS, by
completing the following steps:

Step Action

1 Access the Options screen. Click on the Status Information
tab if this is not displayed by default.

From within the Status Information tab, data for the following
fields can be viewed:
 Process ID
 Module
 Version (of LIS)
 LAD Version
 Status
 Time Start
 Time End
 CAPN
 Import Process ID
 Count – details a count of records imported for a specific

datasets listed below
 Source – details a list of data sets imported, including:

 Total Learners imported
 Fully Validated Learners
 Learners with warnings only
 Programme Aims
 Aims
 HE Datasets
 Rule Violations

Navigate through the Status Information tab, using the scroll
bars available.

2 If you want to see a list of processes that have taken place,
click the Show History check box at the bottom of the screen.

The history information displays, within the Status Information
tab for the selected Provider.

Continued on next page
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15. Maintaining LIS Options, Continued

15.3
Maintenance
Options

The Maintenance tab within Options allows you to carry out some
maintenance tasks within LIS, complete the following steps:

Step Action

1 Access the Options screen. Click the Maintenance tab.

The Maintenance tab offers the following options:
 Provider Selection
 Truncate Log
 Clear Locks
 Compact DB
 Update Data.
 Postcode Factors

2 Click on a button to conduct a specific operation.

IF... THEN...

You wish to change your
provider

Click on the Provider…
button. Go to Section 7.3
Change the Provider (See
page 26).

You wish to truncate the log
file

Click on the Truncate Log
button. Go to Section 15.4
Truncating the Log (See
page 75).

You wish to clear locks Click on the Clear Locks
button. Go to Section 15.5
Clearing Locks (See page
76).

You wish to compact the
database

Click on the Compact DB
button. Go to Section 15.6
Compacting your Database
(See page 77).

You wish to update the data
used by LIS

Click on the Update Data
button. Go to Section 15.7
Updating your LIS Data
(See page 78).

You wish to update the
Postcode Factors used by
LIS

Click on the Change button.
Go to Section 15.8
Updating your Postcode
Factors (See page 78).

Continued on next page
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15. Maintaining LIS Options, Continued

15.4 Truncating
the Log

The LIS application keeps a log of some of the events or operations carried
out. Refer to Section 17.2 Viewing the Audit Log for more information (See
page 82). The log file is useful for diagnosing problems, but it can be
truncated if required. Truncating the log erases all the log entries and is
useful if you wish to save hard disk space.

To truncate the log, follow the steps listed below:

Step Action

1 Access the Options screen. Select the Maintenance tab.

Click on the Truncate Log button.

The following warning message is displayed “Ok to truncate the
log file? This action is not reversible”.

2 Select an option:

IF... THEN...

You click Yes A confirmation message
displays.
The truncation is complete.
Go to step 3.

You click No You return to the
Maintenance tab and no
truncation has taken place.

3 Click OK.

You return to the Maintenance tab.

Continued on next page
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15. Maintaining LIS Options, Continued

15.5 Clearing
Locks

Locks will occur within LIS if processes remain incomplete, for example if
your PC is switched off during an import. Error messages will prevent you
from completing some operations.

If this occurs then the Clear Locks option should be used:

Step Action

1 Access the Options. Select the Maintenance tab.

Click on the Clear Locks button.

The following warning message is displayed “Ok to clear
process control locks? This action is not reversible”.

2 Select an option

IF... THEN...

You click Yes A confirmation message
displays.
Go to step 3.

You click No You return to the
Maintenance tab screen
and no locks have been
cleared.

3 Click OK.

You return to the Maintenance tab screen.

Continued on next page
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15. Maintaining LIS Options, Continued

15.6
Compacting
your Database

You can compact the database within LIS, to save hard disk space.
However, the LIS performs self-compaction after validation so this option is
generally only useful for providers with exceptionally large files.

To compact the database, complete the following steps:

Step Action

1 Access the Options screen. Select the Maintenance tab.

Click on the Compact DB button.

The following warning message is displayed “Are you sure you
wish to compact the database?”.

2 Select an option.

IF... THEN...

You click Yes A confirmation message
displays.
Go to step 3.

You click No You return to the
Maintenance tab screen
and the database has not
compacted.

3 Click OK.

You return to the Maintenance tab.

Continued on next page
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15. Maintaining LIS Options, Continued

15.7 Updating
your LIS Data

You can update static data used by the LIS, for example the Provider list or
Postcode list . You will only need to do this when an update is released on
the LIS pages of the Data Service website.

To update your LIS data, follow the steps below:

Step Action

1 Download the updated data file from the LIS pages of the Data
Service website to your PC.

2 Access the Options screen. Select the Maintenance tab.

Click on the Update Data button.
3 The Select Lookups Update File dialogue box displays.

Navigate through the directory and select your data file for
updating LIS.

4 Click Open. The selected file updates data within LIS.

To close the Select Lookups Update File window, without
selecting a directory or changing the filename, click either
Cancel or .

You then return to the Maintenance tab.

15.8 Updating
your Postcode
Factors

You can update static Postcode Factors data used by the LIS. You will only
need to do this when an update is released on the LIS pages of the Data
Service website.

Use the following steps to update your LIS data:

Step Action

1 Download the updated data file from the LIS pages of the Data
Service website to your PC.

2 Access the Options screen. Select the Maintenance tab.

Click on the Change button.
3 The Select Postcode Factors Database Path dialogue box

displays. Navigate through the directory and select your data
file for updating LIS.

4 Click Open. The selected file updates data within LIS.

To close the Select Postcode Factors Database Path window,
without selecting a directory or changing the filename, click
either Cancel or .

You then return to the Maintenance tab,with the file location
path, Area Cost Factors and Disadvantage Factors details
showing as being updated.
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15.9 Viewing
Import Errors

You can view a list of import errors that may be encountered when importing
ILR data into LIS, complete the following steps:

Step Action

1 Access the Options screen. Select the Import Errors tab.

2 The import errors tab screen displays, showing details for error
 Name
 Description
 Field Values
Click on an error in the list for more details.

15.10 Viewing
Version
Information

You may need to know which version of the LIS and the LAD you are using.
For example, this information is useful when updating software, maintaining
data and requesting support.

To view version information from within the LIS application, complete the
following steps:

Step Action

1 Access the Options screen. Click the Version Information
tab.

The version information tab screen displays. It is read only and
shows version information for:
 Learner Information Suite

o Database
o Application
o Validation Rules

 Learning Aim Database
o Version

 Modules
o LR Funding calculation
o ER Funding calculation
o DLF Common
o Derived Data Collection

 Lookup Tables
o Providers
o Postcodes
o TtG Brokers Contracts
o Postcode Area Cost Factors
o Postcode Disadvantage Factors

Continued on next page
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15. Maintaining LIS Options, Continued

15.11
Maintaining
Postcodes

Postcodes can be maintained from within LIS. You can search for existing
postcodes or insert new postcodes into the list.

15.12
Searching for
Postcodes

To search for postcodes, complete the following steps:

Step Action

1 Access the Postcodes screen.

The list shows all postcode records for you to view. Move
through the list using the scroll bar or the navigation buttons

.
2

If you click the drop down next to the search button you
have two options:

IF... THEN...

You click All Records The list is refreshed to
display all postcode records
within LIS.

You click Some Records. The Select Filter Required
dialogue box displays.

Go to step 3.

3 Click on the drop down for Data Field to select a category for
your search.

Three Filter options are available:
 Council entered
 Description
 Outward Postcode.

4 Enter a value in the Filter field.

Note: wildcard characters are NOT allowed.
5 Click on the Filter button. Your search results display.

Cancel will cancel the search.
6 Upon selecting a Postcode, the current PostCode Detail and

position in current result set fields are updated as appropriate

Continued on next page
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15. Maintaining LIS Options, Continued

15.13 Inserting
New Postcodes

It is possible to insert new postcodes into the list within LIS.

To insert new postcodes, complete the following steps:

Step Action

1
Click Insert .

The current PostCode Detail section of the screen is populated
with blank fields. The Postcode screen displays.

2 Enter the Outward Postcode in the field.

3 Enter a Description for the postcode.

Note: The inserted postcode defaults Council Entered to N.

The entry displays at the end of the existing list.
4

Click Save Changes .

Click Discard to abort the insertion of the new postcode.

The new postcode is inserted into the list. The list is sorted by
Outward Postcode when it is saved.

15.14 Deleting
Postcodes

It is possible to delete a new postcode added to the list within LIS.

To delete a postcode, complete the following steps:

Step Action

1 Search for the required new postcode, or select it in the list of
postcodes.

2
Click on the Delete button

The selected new postcode will be deleted.
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16. Viewing the Audit Log

16.1 Overview The LIS application keeps a log of some of the events or operations carried
out. Entries to the log file include the time and date of the event and a short
description. The log file is stored in the Auditlog LIS subdirectory by default.

The log file can be viewed from within LIS. The information may be useful
for diagnosis if problems have occurred.

The log can be truncated; refer to Section 15.4 Truncating the Log (See
page 75).

16.2 Viewing
the Log

To view the log file from within the LIS, complete the following step:

Step Action

1 Access the Log screen.

If the log is long, use the vertical scroll bar to view other
operations at the bottom of the list.
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17. Technical Information

17.1 Overview You may want to look at the data stored by LIS. This is outlined in the
section below.

17.2 Looking at
Data Stored by
LIS

The LIS stores data in an internal database. The database is a Microsoft
Access file called LISData2000.mdb. It can be found in
C:\LIS\Release17\Data if the default directory structure is used at the time of
installation.

The file is read-only. An error message will appear if you attempt to open
this file. You can access the database using the LIS database shortcut in
C:\LIS\Release17\. When opening the database with the shortcut type
‘password’ in the password box. This password will correspond to the
password used for LIS itself, so if you changed this, the password for the
database will change also.

To manipulate the data held in the database, you must export the database.
You can use the Export DB function in LIS to export the database.

The export database function does not create a file that is suitable for
transmission to the Data Service. Files which are sent to the Data
Service having been exported from the LIS must be an ILR Export.

The Export DB function exports data stored within the LIS programme in
one of three formats; as a Microsoft Access 2000 file (MDB format), as
dBase III files (DBF format) or as comma separated values (CSV format).

The tables exported by this option are described in the LIS Database
Guidance, for LIS 17.02, available on the LIS pages of the Data Service
website. You can choose to export most of the tables from the LIS internal
database.

If exporting data to a file in dBase format (.DBF file), there is an option to
use short file names rather than long file names. This is to assist users of
Microsoft Access, which does not appear to support use of DBF files with
long file names. The different table names in short dbf format are listed in
the LIS Database Guidance.

Export the database in one of two ways:
 using Batch Import
 using Report Manager.

17.3 Database
Export using
Batch Import

To export the database using Batch Import, see Section 7.10 Export DB
(See page 35).

Continued on next page
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17. Technical Information, Continued

17.4 Database
Export using
Report
Manager

To export the database using Report Manager, complete the following
steps:

Step Action

1 Access the Report Manager screen.

2 Click on the Export DB button.

The Export Database dialogue box appears.
3 You can use the Default Export Settings or select your own:

IF... THEN...

You have the Use default
export settings? check
box checked

You can select an Export
Type from the list by
clicking the appropriate
radio button. Each time a
table is exported you will be
prompted for an Export
Type for that table.

You uncheck the Use
default export settings?
check box

The Export Type options
are disabled and all tables
will be exported in the same
format.

You check the Use short
files names for DBF
export check box

Short file names will be
used in the export.

You uncheck the Use short
files names for DBF
export check box

Default settings for file
names are maintained.

4 The export path is read-only. Click OK.

Cancel will cancel the database export.
5 A confirmation message displays after exporting the

database. Click OK.
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18. Command Line Option

18.1
Overview

The Command Line option allows you to run the LIS without using the LIS
application interface. You can therefore run the LIS in the background or at a
time more convenient to you, for instance running a large ILR data file
overnight. When the LIS is run in this way it refers to the ‘saved defaults’
within the ‘Batch Import’ screen.

This operation can be called from Scheduled Tasks, located in the Windows
Control Panel. This allows you to run the operation at a specified time and
date.

Or it can be started by an MS-DOS command line prompt. This can either be
run from the Command Prompt or saved as a text file and run immediately
when executed from its icon.

18.2 Preparing
LIS to run the
Command Line
Option

To prepare LIS to run the command line option, complete the following
steps:

Step Action

1 Launch LIS and navigate to the Batch Import screen.

2 Select the following import options:
 provider number and name
 collection and type
 Learning Aim Database
 at least one operation.

Note: These options are mandatory and must be selected before
attempting to run the command line option.

3 Select any of the optional extras:
 type of validation
 export options
 report options.

Note: Any files in the ‘Files selected to import’ area will be
overwritten by the files referred to in the command line.

4 Click the Save Defaults button.

IF... THEN...

The saved defaults are
not set on the Batch
Import screen

The batch operation will not run
and the audit log file will be
populated with the error ‘Default
Settings not set – LIS Batch
Operation cancelled’.

The saved defaults
are set on the Batch
Import screen

The batch operation will run
successfully.

Continued on next page
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18. 18. Command Line Option, Continued

Step Action

5 Exit the application.

To ensure integrity of the database, LIS must be closed before
the command line function executes. If LIS is running on your
machine, the error ‘LIS already in use – LIS Batch Operation
cancelled’ is written to the audit log.

18.3 Viewing
Error
Messages

When running LIS using the command line option, all error messages are
suppressed. Suppressed error messages are written to the LIS audit log file.
An entry is created for each operation in the audit log.

18.4 Setting up
a Scheduled
Task

To set up a task using the Task Scheduler, follow the steps below:

Step Action

1 Run the Task Scheduler application from within the Control Panel.

2 Select Add Scheduled Task and follow the on-screen instructions.

3 You will need to tell the scheduler where the LIS has been
installed; when and how often to run the LIS; and you may need
to add your machine login details so the task runs as if it were
started by you.

18.5 Cancelling a
Scheduled Task

To cancel a task that is set to run at a specific time and date, follow the
steps below:

Step Action

1 Run the Task Scheduler application from within the Control Panel.

2 Either untick the ‘enabled’ checkbox and click on ‘Apply’, or select
the scheduled task and chose ‘Delete’.
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18.6 Command
Line Syntax

The command line function requires three parameters:
 the filename to import
 the file path of the import
 the file path of the exported LIS_exp.mdb database.

The way these pieces of information are coded is as follows:
 -i <import directory>
 -f <filename to import>
 -e <export directory>

A complete piece of command line syntax would be as follows:
C:\LIS\Release17\LIS.exe –e D:\MyExportFolder –i D:\MyImportFolder -f
a99999500260091000201.W01

Which breaks down as:
 ‘C:\LIS\Release17\LIS.exe’ , which triggers the LIS from its .exe file in

the C drive and folders as specified
 ‘-i D:\MyImportFolder’, which tells the LIS to look in the MyImportFolder

in the D drive for the file defined by –f
 ‘-f a99999500260091000201.W01’, which tells the LIS the name of the

file to import
 ‘-e D:\MyExportFolder’ , which tells the LIS to export the LIS_exp.mdb to

the folder in the D drive named ‘MyExportFolder’

In addition to the above guidance:
 If the import file path is defined by -f, for example: -f

D:\MyImportFolder\a99999500260091000201.W01, then the parameter
set by -i will not be used and is therefore not necessary.

 If no file path is stated, for -i the last known import file path will be used
and for -e the default LIS\Exports folder will be used.

 Another program can be run from the command line by using the –r
parameter in the syntax. An example of the –r parameter is: -r
c:\Program Files\Microsoft office\office11\MSACCESS.EXE
“c:\test.mdb”. The latter part in quotes directs the program to the file to
be opened.

Continued on next page
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18. 18. Command Line Option, Continued

18.7 Running an
MS-DOS Prompt

To set up and run an MS-DOS prompt, complete the following steps:

Step Action

1 Click Start from the task bar at the bottom of your screen.

2 Select All Programs > Accessories > Command Prompt.

The Command Prompt box displays. The prompt flashes.
3 Type in the command line syntax.

4 Press Enter to run the LIS operation.

5 To stop the operation, press Cancel from the LIS Batch Import
screen.

18.8 Creating
an MS-DOS
Command Line
File

To create an MS-DOS command line file (or 'Batch file') in Notepad,
complete the following steps:

Step Action

1 Open a new Notepad document.

2 Type in the command line syntax.

3 Save as a .bat document.

4 To run the MS-DOS code within the document, double-click the
document icon.

5 To edit the document, right click on the icon and select Edit.
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19. Glossary

19.1 Glossary Details of abbreviations and acronyms used within this document. Terms
are listed alphabetically, rather than in order of appearance, and using the
correct Upper or Lower case as you would expect to see them.

Term Definition of Term
ALS Additional Learning Support
csv Comma Separated File
DB Database
dbf Database File
DSAT Data Self-assessment Toolkit
ER Employer Responsive
ESF SR European Social Fund Employer Responsive
IA Information Authority
ILR Individualised Learner Record
LAD Learning Aim Database
LIS Learner Information Suite
LLSC Local LSC
LR Learner Responsive
LSC Learning Skills Council
mdb Microsoft Access Database file format
MS-DOS Microsoft Disk Operating System
OLDC Online Data Capture System
UFI University for Industry
UPIN Unique Provider Identifier Number

20. Further Information

20.1 Further
Information

Additional information that may be useful when using the guide and the
LIS

ILR 2009/10
Specification

Specification of the Individualised Learner Record Batch Data Capture File
for 2009/10 – available from
http://www.theia.org.uk/downloads/ilrdocuments/ilrdetail2009_10.htm

Validation rules
spreadsheet and
guidance

Validation rules release 6 (as used in LIS 17.02 ) and guidance – available
from http://www.theia.org.uk/downloads/ilrdocuments/ilrdetail2009_10.htm


